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Introduction 

Isimsoftware Scan is a desktop scanning software for TWAIN compliant scanners. The 

scanned documents can be saved in TIFF, PDF and several other graphics formats. For TIFF 

and PDF the output files can be multi-page. 

 

The program requires Microsoft Framework 4.0 or higher. If you don’t already have the 

Framework installed on your computer, it is freely downloadable from the Microsoft website. 

 

From time to time check the availability of later versions of the program and always run the latest 

version. Version update information is accessible via the Help menu. 

 

Helpful hint: Instead of right-clicking on the thumbnail or image objects, use ‘press and hold’. 

Always ensure that all affected files are safely backed up, and always review the output files. 

 

Trial version 

You may use the free trial for thirty (30) days. After 30 days you uninstall the trial software or 

purchase a software license. The trial version displays a demo message. At random, a demo notice 

is added to the output file. Use the trial version only for testing. 

 

When you purchase a license you receive an unlock key. The unlock key, entered in the 

Help/Register menu, converts the demo version to a licensed version. 
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Trouble shooting 

To diagnose scanning problems, please do the following: 

 

 Turn off the scanner (turn off power), then turn on again and reboot your computer. This 

often clears the problem. 

 

 Re-select the scanner. 

 

 Toggle between the Flatbed and ADF/Flatbed dropdown list. 

 

 If you get an error message to the effect that the ‘scanner is already used by another 

application….’, turn the scanner off the, wait a couple of seconds, then turn it on again. 

This will clear the problem. 

 

 Make sure that you have the latest TWAIN driver for your scanner model. TWAIN drivers 

can be downloaded from the scanner manufacturers’ websites. Isimsoftware Scan 

only supports TWAIN-compatible scanners. 

 

 Check the Scanner selection and make sure that you have selected the correct scanner. 

Some scanners are shown in two modes; the WIA version may not work for an ADF scan. 

 

 If your scanner is set to ‘scan ahead’ disable that option. Scan Ahead (sometimes called 

Fast Scan) setting may result in pages being skipped. 

 

 Check and see if there is other scanning software running at the same time. This may slow 

down the scanning. Disable all other scanning software. Some scanners come with their 

own scanning software; disable it. 

 

 For a test, scan with the scanner’s own dialog (check the Show scanner dialog’ checkbox) 

and see if that solves the problem. 

 

 If the scanner is operated over a network, determine if the problem is network related, 

like slow data transmission. Run the scanning directly (scanner attached to your computer 

and saving to your own drive) and see if that works. 

 

 If the scanner does not work in Duplex mode, it may be that the Duplex needs to be set in 

the scanner’s own dialog. This is necessary with some scanner models. 

 

 Check all the cable connections; make sure that there is no electrical interference. 

 

 If the problem persists, the scanner may be defective or the Isimsoftware Scan software 

may be incompatible with the scanner. 

 

 Check the web link in the Help menu for an updated FAQ listing. 
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Quick tutorial 

 Launch the program by clicking the icon on your screen’s desktop, or double-click the 

Isimsoftware Scan executable file in the program folder, generally in the C:\Program Files 

(x86)\Isimsoftware folder. 

 

 Select the source of the documents: Flatbed or ADF (Automatic document feeder). Select 

the scanner, if not already defaulted. 

 

 Choose from the list of preset document size specifications. Only the basic paper sizes are 

listed. You can create your own Presets in the Setup menu: size, resolution, color, etc. 

Alternatively, scan with the scanner's own interface (Scan UI button). 

 

 Choose the scanning options, such as Duplex, Deskew, Despeckle, Exclude blank pages, 

Rotate (Auto-rotate, 180, 90, -90 degrees). Most can be set as defaults in Setup. 

 

 If you use separator pages, check the 'Separator pages' checkbox. 

 

 Press 'Scan' or 'Scan UI' (scanner's User Interface). The pages are scanned to a 'workfile'. 

You can also scan directly, without workfile, with options in the Scan menu, or press-and- 

hold Scan buttons (or click with SHIFT). A workfile displays the scanned pages as 

thumbnails and allows you to edit and re-arrange the pages before you save the 

document. If you scan without workfile, the scanned document is directly saved and no 

edits are possible. 

 

 Many edit options are available, including rotation, removal of borders, cropping, 

redaction, deskew, redaction, highlighting, watermarks, restoring. To edit the scanned 

images, simply open the image and right-click (or press-and-hold) and choose from the 

many options. 

 

 To re-arrange, exclude or group pages, right-click or press-and-hold the thumbnail and 

choose an option. Options are available in the Workfile menu. 

 

 If you save the output to Tiff or PDF format, specify the Tiff compression. 

 

 Select the Save options (single, multi-page, serialized, separated). Click Save button. 

 

 If you need to append scanned pages to an existing TIFF file, open the existing TIFF file 

BEFORE you start scanning; open the file via the option in the File menu. The scanned 

images can then be inserted at a selected page or appended front or back, as prompted 

by the system. You can also add a file page after scanning (via File menu). 
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Scanning 

The program supports TWAIN-compliant scanners. Ensure that your scanner has the latest 

TWAIN driver. TWAIN drivers can be downloaded from the scanner manufacturers’ websites. 

 

By default, the scanned pages are placed in a temporary workfile. The current image is displayed 

in the main window and all pages in the workfile are shown in a scrollable thumbnail display. The 

displayed image can be resized by clicking the display option icon in the left side panel. 

Alternatively, you can resize the main window by dragging the lower right corner. The pages can 

then be re-arranged, removed, and page-separated. The images can also be edited (remove black 

borders, deskew, rotation, cropping, redaction, watermark, etc). . For more detail, see separate 

sections below. 

 

There are also options to scan and save directly, without the workfile, via the Scan menu, or press- 

and-hold the Scan buttons. 

 

If you only have one scanner on your computer, the program should defaults to that scanner. 

 

Scanners are of either the Flatbed or Automatic document feeder (ADF) model, or both. If you 

select the ‘ADF or Flatbed’ option, most scanners pick the documents from the feeder if loaded, 

otherwise it scans from the flatbed. 

 

Choose the paper size of the scanned documents. Only the most common paper sizes and 

resolutions are listed in the dropdown lists. You can create up to twelve additional presets in 

Setup. Each preset can have its own size, scanning area, color setting, resolution, brightness, 

contrast, etc. Alternatively, scan with the scanner’s own user interface and specify your own scan 

settings. To scan with the scanner’s own interface, click on the ‘Scan UI’ button instead of the 

‘Scan’ button. 

 

There are several scanning settings: 

 

Duplex enables duplex scanning. For some scanner models, the Duplex mode can only be set via 

the scanner’s own dialog. If your scanner does not have a Duplex feature, you can simulate 

duplexing. See section below. 

 

Check the Deskew checkbox to automatically straighten skewed pages, where possible. A manual 

Deskew option is also available by right-clicking the displayed scanned image (or press-and- 

hold). 

 

If the Despeckle checkbox is checked, stray pixels are removed from the scanned pages (the 

result is limited). 

 

The program has an option to exclude virtually blank pages. To exclude blank pages when 

scanning, you must check the Exclude blank pages checkbox before you start scanning. Pages 

can also be excludes in the workfile after scanning. 

 

If the Auto-Rotate option is checked, the images are rotated 180, 90 or 270 degrees (upside, 

clockwise, counterclockwise) during the scanning process. This option is typically used if stacks of 
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paper are inserted in the tray upside down to avoid jamming due to staple marks. If you use auto- 

rotate, any separator pages must also be in the correct orientation. Individual pages can also be 

rotated (90, 180 and 270 degrees) in the workfile, after scanning. 

 

You may want to scan via the scanner’s own dialog, or scan without a dialog. The scanner’s own 

dialog (user interface) often provides access to special settings. For some scanners, certain 

options (for example Duplex) can only be set via the scanner’s dialog. To use the scanner’s dialog 

(user interface), press the ‘Scan UI’ button instead of the ‘Scan’ button. 

 

If a workfile already exists, the system will prompt you to either clear the workfile or select an 

append option. 

 

The program supports Separator pages. The format of Separator pages is explained in a separate 

section below. For the system to recognize separator pages when scanning to the workfile, the 

checkbox must be checked. You can also insert or remove separator pages in the workfile after 

scanning. See workfile section below. 

 
Appending pages to existing TIFF File 

If you need to append scanned pages to an existing TIFF file, use the following procedure: 

 

 Open the existing TIFF file from the File menu. The pages are displayed in the workfile. 

 Scan the new pages. The system will ask you if you want to add the scanned pages at the 

back, in front, in between. 

 Save the workfile. 

 

You can also add pages of an existing file to the end of the workfile, and once so inserted you can 

move it to any position. Open the existing file from the File menu and select the page. 
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Scan and save directly without the Workfile 

You can scan and save directly without a workfile. You will find the options in the Scan menu. 

Additional options are available in the Scan menu. 

Scan and save without workfile – Regular 

Scan and save without workfile – Serialized 

Scan and save without workfile – Separator pages 

Scan and save without workfile User interface – Regular 

Scan and save without workfile User interface – Serialized 

Scan and save without workfile User interface – Separator pages 

 

The shortcut keys are shown in the menu listing. 

Alternatively, right-click or press-and-hold the ‘Scan’ or ‘Scan UI’ buttons. 

If you need to append to an existing TIFF file, use the workfile method. 

 

Save 

After the scanning is done, the pages in the workfile must be saved. If you scan and save directly, 

you can ignore this section. 

 

The available options are listed in the dropdown list in the ‘Save’ section: 

 

 Save the current page only. 

 

 Save the entire workfile as one multi-page TIFF or PDF file. 

 

 Save each page as a separate file. The file names are then serialized, with a serial suffix 

added to the file’s base name. The suffix by default is _00001 but you can define your 

own format of suffix in the Setup, with or without a separator character. Alternatively, you 

can specify the suffix serial as a placeholder, for example myfile[+1001].tif or 

myfile[+_001].tif. Exact syntax [+…] is important (note the character ‘+’). By 

default, the numeric suffix is incremented by one unit, but the number of units can be 

changed in Setup. Unlike in previous versions, ending numbers in the file’s base name are 

no longer used for serialization. 

 

 Save the pages into several single or multi-page files as set by the separator pages in the 

workfile. The files are also given a serialized suffix, as above. 

 

 Save the files marked with a checkmark. Only the files marked will be saved, either as one 

multi-page file or as individual serialized files. 

 

The Save dialog typically defaults to the last saved file name. If the file name has a numeric suffix, 

the number is automatically incremented by one unit. You can auto-generate the filename based 
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on the current date and time, for example 20140909_123456.tif.To effect this option, go to Setup 

and check the ‘Automatic file naming’ checkbox. 

 

To save as PDF, you must give the file name a .pdf extension. The program supports both the 

standard PDF and the PDF/A -1b format. PDF/A files are for long-term archiving. 

 

Optionally you can specify a Default folder. Click on the Default Folder box and select the folder. 

In Setup, you may specify up to eight default folders, each with a user-friendly name. The default 

folders are then listed in the pull-down list in Default Folder box for easy selection. 

 

To launch the saved file automatically, check the Auto-launch checkbox immediately below the 

Save button. The file will be opened automatically in the application that you specified as ‘Launch 

Application A’ in Setup. 

 
File formats 

Multi-page files can be saved as TIFF or PDF files. 

Single (or serialized) files can be saved as TIFF, PDF, BMP, GIF, PNG or JPEG files. 

 

TIFF format 

 

There are three supported TIFF formats: 

 

 TIFF LZW 

LZW formats support both monochrome (black and white) and color. 

 

 TIFF CCITT4 (Group 4) 

CCITT4 supports only black and white (monochrome) files. CCITT4 offers the best 

compression and is the most widely used TIFF format. If the current image is in color and 

you must save it in CCITT4 format, the colors must first be dithered into a monochrome 

image; right-click on the image and select ‘Dither image to monochrome’. If you specify 

CCITT4 and the image is in color, the page will be saved as LZW. 

 

 TIFF CCITT3 (Group 3) 

CCITT3 supports only black and white (monochrome) files. It is now a virtually obsolete 

format, but still used for some faxing applications. Use it the same way as CCITT4 above. 

 

 TIFF JPEG 

TIFF JPEG supports is for color photo-type images. The compression is superior for 

photo-type images (images that have no solid color areas). Use this option only for 

photo-type images. TIFF JPEG files are not supported by all software. 

 

Generally, but not in all operating systems, a multi-page TIFF file can be a mix of different TIFF 

compressions. If a page is a photo-type image, you may want to choose the TIFF JPEG 

compression for that page as it provides the best possible compression. However, keep in mind 

that not all software supports the TIFF JPEG format. 
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PDF Format 

 
The program supports PDF output. Internally, the system may first create a TIFF file, then convert 

the temporary TIFF file into PDF. For large multi-page files, the TIFF-to-PDF conversion can take a 

considerable time. For serialized conversion, the progress bar indicates the status of the progress, 

but the progress bar is not active for conversions of multi-page conversions, so the time may 

appear longer that it really is. Typically, for a monochrome page, the TIFF-to-PDF conversion is 

about half a second per page; for color it will be slower. 

 

PDF files can be standard or encrypted (if processed via the workdfile). If you create an encrypted 

file, the system will prompt you to enter the password (user password). If you have opted to hide 

the password on the entry screen, the password must be entered twice. 

 

Please note that PDF files created by scanning are raster files and thus are not text-searchable. 

The compression of the embedded raster image is as per the TIFF compression that you selected. 

 

To save as PDF, you must give the file name a .pdf extension. 

 

BMP, GIF, PNG or JPEG formats 

 

These formats are valid only for single (or serialized) files. They support color. 

 
Workfile 

As the pages are scanned, or opened from a TIFF file, they are added to the workfile. The current 

image is displayed in a large window; all the pages in the workfile are shown in a scrollable 

thumbnail display. If you scan and save directly, you can ignore this section. 

 

The pages can be re-arranged, removed (and re-inserted), check-marked and rotated. Page 

separators can be inserted. 

 

Right-click (or press-and-hold) a thumbnail for a pull-down menu for: 

 

 Move clicked page 

A prompt window will ask you where you want to move the page. You can move the page 

to the beginning, to the end or to any page number. 

 

 Add separator above clicked page 

A page separator will be inserted above the clicked page. 

 

 Remove separator above clicked page 

An existing page separator above the clicked page will be removed 

 

 Exclude (remove) clicked page 
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The clicked page will be removed. You can later re-insert the removed page from the Edit 

-> Restore menu. 

 

You will find additional options in the workfile menu: 

 

 Reverse the page order 

This options reverses the page order; the last page becomes the first page, and vice versa. 

 

 Duplex simulation 

The Duplex Simulation Scanning option re-arranges the pages as if they were scanned in 

a duplex mode. So, with a regular ADF scanner, scan the stack upside, then scan the same 

stack downside. The Duplex Simulation will then re-arrange the pages in 1-10-2-9-3-8-4- 

7-5-6 order. The Duplex Simulation Printing is similar, but the pages are re-arranged in 

the order 1-3-5-7-9-10-8-6-4-2. 

 

 Add/remove separator pages 

Separators can be added globally at all check-marked pages, or at intervals, for example 

even-numbered pages. The option also allows you to remove all separators. 

 

 Add/remove checkmarks 

Checkmarks can be added globally to all pages, or to all pages between existing 

checkmarks (first set). The option also allows you to remove all checkmarks. 

 

 Move checkmarked pages 

This options allows you to move the check-marked pages globally to the beginning, to 

the end, or to any page location. 

 

 Exclude all blank pages in the workfile. 

This option is valid only for monochrome (black and white) images and is valid only for 

un-edited pages 

 

 Restore Workfile 

This options restores the workfile. All checkmarks and separators are removed. The 

pages are arranged in the order the pages were added to the workfile. So, for example, if 

you scan pages and append them in front; these pages may appear at the end. Use this 

option with caution. 
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Editing 

The individual scanned images can be edited. Click on the thumbnail to display the page in the 

large window. Right-click (or press-and-hold) the image, or use the option from the Edit menu: 

 

Redact (white-out, black-out, Highlight) 

 
Select the option in the Edit menu. With the left mouse button pressed, outline the area that you 

wish to redact. In the popup Confirmation window select Yes or Cancel. If you need to white-out 

many spots around the rim of the image, it is suggested that you use the ‘Clean-up borders’ 

function (see below). 

 

Watermark 

 
Select the option in the Edit menu. Enter the text of the watermark and click on the vertical spot 

where you want the watermark entered. It will be horizontally centered. In the popup 

Confirmation window select Yes or Cancel. 

 

The default font size is 24, but you can specify a different size by adding a pipe character and the 

font size after the watermark text, for example Copyright|30. 

 

Crop 

 
Select the Crop option. With the left mouse button pressed, outline the area that you wish to 

crop. In the popup Confirmation window select Yes or Cancel. 

 

Deskew 

 
Select the Deskew option. With the left mouse button pressed, draw a line along the slope of the 

skew. When you release the mouse, the image will be rotated by the angle of the skew. In the 

popup Confirmation window select Yes or Cancel. Always do the Deskew as the first Edit action. 

 

Remove black background 

 
This option floods the black borders with white. You can thus remove black edges created if the 

scanner uses a black background. Use this option with caution; any black border that connects 

un-interrupted with the image will cause part of the image to be flooded in white. In the popup 

Confirmation window select Yes or Cancel. 

 

Clean-up borders 

 
This option can be applied to clean up the border area, for example to clean up punch holes or 

staple marks. The option works like the crop, but the cropped rectangle is placed back onto a 

white canvas that has the original size of the image at the original location. With the left mouse 

button pressed, outline the area that you wish to keep (which would be the inside area of the 

image). In the popup Confirmation window select Yes or Cancel. 
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Convert image to 1-bit or 8-bit 

 

Use the option if the image is in color and you wish to save it in monochrome or 256-color. 

 

Rotate 

 
This option rotates the currently displayed image at 90, 180, or 270 degrees. You can also rotate 

a group of pages with the Rotate option in the workfile. Furthermore, it is possible to rotate all 

pages 180 degrees while they are scanned. 

 

Other 

 
For more edit options, please use our Isimsoftware Image Viewer program. The Isimsoftware 

Image Viewer program includes many other edit options such as text bubbles, insert 

images, highlighting, freehand drawing, shapes, arrows, text inserts, even curved text. A demo 

version can be downloaded from www.isimsoftware.com or . 

 
Separator pages 

The program supports barcode separator sheets. Separator sheets allow you to scan a batch of 

documents and automatically increment the file name when a separator sheet is encountered. 

Separator sheets can also be configured to add a suffix or a prefix to the file name, so as to 

separate a scanned batch of documents into groups. 

 

The standard separator pages must be of a specific format. The standard format is a Code39 

barcode with the text ..NEW (two dots followed by the word NEW) placed in the upper section 

of the page. Standard separator sheets can be printed from the Setup menu. For special custom 

separator sheets, see section below 

 

If you scan to the Worksheet, a separator bar is inserted to the thumbnails display in place of the 

separator sheet. When you save the Workfile, the separated pages are serialized, with a serial 

suffix added to the file base name. The suffix by default is _00001 but you can define your own 

format of suffix in the Setup, with or without a separator character. Alternatively, you can specify 

the suffix serial as a placeholder in the file name, for example myfile[+1001].tif or 

myfile[+_001].tif. Exact syntax [+…] is important (note the character ‘+’). By default, the 

numeric suffix is incremented by one unit, but the number of units can be changed in Setup. 

Unlike in previous versions, ending numbers in the file’s base name are no longer used for 

serialization. 

 

If you scan directly (without the Worksheet) the file name is given the serial suffix each time a 

separator sheet is encountered. 

 

Place the separator pages in your stack of documents. Check the Separator Pages checkbox 

before you start scanning. If scanning to the workfile, the separator pages will insert a separator 

line in the workfile’s thumbnail display. The separator line can be removed by right-clicking on the 

thumbnail. Separator pages can also be removed globally via the workfile menu. 

http://www.informatik.com/
http://www.informatik.us/
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If you scan in Duplex mode AND you set the ‘Excl blanks’ (exclude blank pages), the separator 

sheet must NOT be blank at the back. 
 

Please pay special attention to the scanner’s handling of separator pages when you scan in Duplex. 

The following rules apply: If you scan with the scanner’s dialog and you set the duplex mode in the 

scanner’s dialog AND you specify Exclude Blank Pages in the scanner’s dialog, then DO NOT check 

the Duplex or the ‘Exclude Blank Pages’ in the Isimsoftware Scan window. If you scan with the 

scanner’s dialog and you set the duplex mode in the scanner’s dialog but you do not specify Exclude 

Blank Pages in the scanner’s dialog, then you MUST also check the Duplex in the Isimsoftware Scan 

window. 

 

Also available at no extra fees is a batch scanning software where files are named according to 

barcodes on the documents. More than 10 barcode symbologies are supported. The program can 

be downloaded from www.isimsoftware.com (Download tab). For licensing, use the same code 

as for Isimsoftware Scan. 

 

Separator sheets that add prefix or suffix to file name 

 
A special format of separator pages can be used to add a prefix or suffix to the file name. The 

option is useful if you scan a stack of paper of one subject matter but that has various sub- 

sections that you wish to save to separate files, but with a common base name. 

 

In order for the scanning program to recognize the separator sheet, the barcode text must have a 

double-dot prefix, such as ..CHART. If the scanner Recognizes a separator sheet with the text 

..CHART, for example, the CHART suffix will be added to the base file name, so myfileCHART. To 

create a prefix (instead of suffix), add a slash character to the string, like ..CHART/. 

 

Insert virtual separators pages into the Workfile: 

 
You can also insert separators in the thumbnail display. Simply right-click on the thumbnail and 

choose the option from the popup menu. Furthermore, with options in the workfile menu, 

separator pages can be inserted for all check-marked pages. To remove all separator pages, use 

the option in the workfile menu. 

http://www.informatik.com/
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Custom barcoded separator pages 

If you need a custom method for barcode-based page separation, enter your specifications in 

Setup. The setup specification string consists of seven (7) values, each separated by a semi- 

column: " 

 

1. Separator String (letter or word in the barcode that signifies a separator) 

2. Barcode Type (number): 

1=Code39 

2=Code128 

3=Code11 

4=Code93 

5=CodeI25 

6=CodeS25 

7=Codabar 

8=CodeEAN 

9=CodeEANPlus 

10=CodeUPCE 

3. Save barcoded page: if set to zero (0), the page with the barcode is NOT saved; if set to 

1, then the page is saved. 

4. Area of interest (where the barcode is located): Left (in Inches) 

5. Area of interest (where the barcode is located): Top (inInches) 

6. Area of interest (where the barcode is located): Width (in Inches) 

7. Area of interest (where the barcode is located): Height(in Inches) 

Example: S;4;1;0;0;8.5;11 

 

Display and page navigation 

All scanned images are shown miniaturized in the scrollable thumbnail display. The current image 

is also shown in the main window. 

 

The image in the main window can be displayed full size, fit-to-width or fit-to-size. The sizing 

options are available in left sidebar. You can also resize the displayed image by dragging the size 

grip in the window’s bottom-right corner. 

 

To navigate through the pages, click on one of the navigation icons in the left sidebar, use the 

scrollbar of the thumbnails and click on a thumbnail. You can also press one of the arrow keys on 

the keyboard, or the Page Up, Page Down, Home or End keys. 

 
Rotation 

An individual image can be rotated at any right angle by right-clicking on the image window (or 

press-and-hold), or by clicking on a rotate icon in the left sidebar. When rotated, the image will 

be saved in that orientation. Finally, a 180 degree rotation can be effected during the scanning 
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process. This option is helpful if you want to scan the documents upside to avoid jamming 

because of staple marks, dog-eared corners, etc. 

 
Convert image to monochrome or 256-color 

A color or grayscale image can be converted to black and white (monochrome) by way of a 

dithering technique. The reformatting may be necessary if you wish to save the image as a 

monochrome TIFF CCITT4 (for example) file. The colors will be converted to black and white pixels 

at distances depending on the brightness of the color. The function is available by right-clicking 

on the image (or press-and-hold) or from the in the Edit menu. 

 

A True Color image can be reduced to 256 colors (8-bit), reducing the file size substantially. The 

function is available by right-clicking on the image (or press-and-hold) or from the in the Edit 

menu. 

 
Printing 

The printing option is available from the File menu with shortcut key CTRL+P. 

 
OCR – Optical character recognition 

The OCR function is basic. Click on the OCR menu button and select the language. Your language 

should be listed on top. With your mouse, outline the image area of interest and press OK. After a 

few seconds the text will be saved in a temporary text (.txt) file and will be displayed in the default 

viewer for text files. 

 

The initial installation of Isimsoftware Scan comes with the English OCR files. Separate files for 

the following languages (listed in alphabetical order) can be downloaded from the Isimsoftware 

website. 

 

Deutsch 

English 

Español 

Français 

Italiano 

Nederlandse 

Português 

 

http://www.isimsoftware.com/files/Tessdata_Dutch.zip 
http://www.isimsoftware.com/files/Tessdata_English.zip 
http://www.isimsoftware.com/files/Tessdata_French.zip 
http://www.isimsoftware.com/files/Tessdata_German.zip 
http://www.isimsoftware.com/files/Tessdata_Spanish.zip 
http://www.isimsoftware.com/files/Tessdata_Italian.zip 
http://www.isimsoftware.com/files/Tessdata_Portuguese.zip 

http://www.informatik.com/files/Tessdata_Dutch.zip
http://www.informatik.com/files/Tessdata_English.zip
http://www.informatik.com/files/Tessdata_French.zip
http://www.informatik.com/files/Tessdata_German.zip
http://www.informatik.com/files/Tessdata_Spanish.zip
http://www.informatik.com/files/Tessdata_Italian.zip
http://www.informatik.com/files/Tessdata_Portuguese.zip
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http://www.isimsoftware.com/files/Tessdata_Fraktur.zip 
Once you have downloaded the language file, unzip it and place the individual files 
in the OCR sub-folder (sub-folder of the folder that contains the Scan12.exe file). 

 
Optionally, in Setup, you can specify the .ozz extension for the text output file. In Setup you can 

associate the .ozz extension to a program of your choosing; the text file will then open in that 

program. This option may be useful if you like the text to be opened in a spell-enabled text 

viewer. 

 
Launch linked applications 

The ‘Launch linked applications’ options allows you to open a program of your choice from within 

Isimsoftware Scan. The last saved filename is sent to the application as an argument. The option 

is useful for opening such programs as viewers, editors, e-mail clients, etc. Up to three (3) 

applications can be specified in Setup.The applications are launched from within the File menu. 

 
Setup 

Setup is accessible via the Setup menu button and allows you to specify certain default settings 

(described in detail in the various sections of this user guide): 

 

 Eight scanning templates (for more than 12 items, see text below). 

 Eight default folders (for more than 12 items, see text below). 

 Scanning options: Deskew, despeckle, separator pages, exclude blank pages, invert, 

duplex. 

 Serialization options: format, increment 

 Launch linked applications: up to three applications 

 Custom separator pages 

 Show scanner progress bar 

 Automatic file naming (based on date and time) 

 

The settings are saved in the c:\Users\[USER]\AppData\Roaming\IsimsoftwareApps\IsimsoftwareScan 

folder. 

 
Templates 

You can create a template (also called profile) for each scan specification (scan size, resolution, 

color depth, etc). When scanning, you can select one of the templates from the ‘Presets’ 

dropdown list. The template selection will be retained and used as the default for the next 

scanning session by the user. 

 

If you need more than eight (12) scanning templates or default folders, add additional 

specifications in the setup5.xml and setup6.xml, using Notepad. You will find the two files in the 

C:\Users\[USER]\AppData\Roaming\IsimsoftwareApps\Isimsoftware Scan folder, or equivalent. Use the 

http://www.informatik.com/files/Tessdata_Fraktur.zip
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setup3.xml and setup4.xml as guides; all entries are in a single command-delimited text line 

towards the end of the file. 

 
Technical support 

For technical support contact information, please go to www.isimsoftware.com . Before 

you contact technical support, please read the Frequently-asked- questions section above in 

this manual. Please also check and make sure that you have the latest version. Please go to the 

Help menu for links to the latest update information and latest FAQ. 

http://www.informatik.com/
http://www.informatik.com/

